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Introduction
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Introduction
Thank you for purchasing the Canon S330 Bubble Jet Printer. This User’s Gui
complete explanations of the features and functions of the printer. 

This guide uses the following symbols to indicate important information. Alway
these instructions.

Warning ➤ Instructions that, if ignored, could result in death or serious pe
caused by incorrect operation of the equipment.
Must be observed for safe operation.

Caution ➤ Instructions that, if ignored, could result in personal injury or m
damage caused by incorrect operation of the equipment. 
Must be observed for safe operation.

Important ➤ Prohibited actions that, inadvertently performed, could result 
damage, faults or impaired product quality.
Must be avoided for correct operation.

Information for Windows users only.

Information for Macintosh users only.

Windows

Macintosh
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How to Use This Manual
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How to Use This Manual
To view this User’s Guide, we recommend that you use Acrobat Reader 4.0 o
Reader 3.0.  Please note that screens displayed by Acrobat Reader 3.0 are s
different.

Use this button to enlarge the 
viewing screen. Select this button in 
the tool bar and click within the 
screen. Displays the nex

Retur
page
previ
viewi

Click to jum
this page.

Displays the prev
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How to Use This Manual

his button 
arch for a 
.

Displays the table of contents.  
Click the heading to jump to the topic.
Click the " " symbol to see the headings for each chapter.
Click the " " symbol to close the headings.

Use t
to se
word
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Safety Precautions
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Safety Precautions
Please read the safety warnings and cautions provided in this manual to ensu
use the printer safely. Do not attempt to use the printer in any way not describ
manual.

Warning ➤ You may cause an electric shock/fire or damage the printer if
any of these safety precautions.

■ Choosing a location

Do not place the printer close to flammable solvents such as alcohol or thin

■ Power supply

Never attempt to plug in or unplug the printer from the power supply when 
are wet.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the 
power cord. Do not place heavy objects on the power cord.
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Safety Precautions

 

mediately 

      

ge the printer.
Never plug the printer into a power socket that is shared with other 
equipment (extension lead, double adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, im
unplug the printer at the power supply and call for service.

Periodically, unplug the printer and use a dry cloth to wipe off any 
dust or dirt collects on the plug and the power outlet. If the printer is 
placed at a location exposed to a lot of dust, smoke, or high humidity, 
the dust that collects on the plug absorbs moisture and may cause 
insulation failure and fire.

■ Cleaning the printer

Use a damp cloth to clean the printer. Never use flammable solvents 
such as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the 
printer, it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could injure yourself or dama
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Safety Precautions
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■ Maintaining the printer

Do not attempt to disassemble or modify the printer. There are no user serv
inside the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure
this guide.

■ Working around the printer

Do not use inflammable sprays near the printer.

This could cause a fire or electric shock if the spray comes into contact with electrical com
the printer.
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Safety Precautions

   

 of these 

   

e vibration.

sunlight, 

 

perature range 

 

Caution ➤ You may cause injury or damage the printer if you ignore any
safety precautions.

■ Choosing a location

Do not install the printer in a location that is unstable or subject to excessiv

Do not install the printer in locations that are very humid or dusty, in direct 
outdoors, or close to a heating source.

To avoid the risk of fire or electric shocks, install the printer in a location with an ambient tem
of 5°C to 35°C (41°F to 95°F) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

Ensure that the area around the power outlet is kept clear at all times 
so you can easily unplug the power cord if necessary.

When moving the printer, carry the printer at both ends.
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Safety Precautions
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■ Power supply

Never remove the plug by pulling on the cord.

Do not use an extension lead.

If you do not intend to use the printer for a long period of time, unplug the p
turning it off.

Never use a power supply voltage other than that supplied in the country o

The correct power supply voltage and frequency is as follows:
Europe: AC 230V ± 10%, 50Hz
USA/Canada: AC 120V, 60Hz
Australia: AC 240V, 50Hz
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Safety Precautions
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■ Working around the printer

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flam
solvents (alcohol, thinners. etc.) on top of the printer.

If any foreign object (metal or liquid) falls into the printer, unplug the power 
for service.

■ Print heads and ink tanks

For safety reasons store print heads and ink tanks out of the reach of smal

If a child ingests any ink, consult a doctor immediately.

Do not shake print heads or ink tanks.

Ink may leak out and stain clothing or the surrounding area.

Never touch the electrical contacts on a print head after printing.

The metal parts may be very hot and could cause burns.
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Printer Parts and Their Functions

  
Printer Parts and Their Functions

• Front View

• Rear View

• Inside the Printer

• Operation Panel
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Front View

Paper Guide
When loading pap
the left edge just t
this guide.
To move the pape
pinch the knob an
the appropriate di

Paper Rest

Sheet Feeder
Load paper he
Paper feeds 
automatically,
at a time.

Front Cover
Open to replace the 
ink tanks or remove 
jammed paper.

Paper Output Tray

Operation Panel
For details, refer to 
"Operation Panel." 



 

Rear View 16

 

Printer Parts and Their Functions

 

.

Rear View

USB Port
Connects the printer to a 
computer through a USB interface
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Printer Parts and Their Functions
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Inside

Inside the Printer

Print Head Lock Lever
Locks the print head into the holder.  
Once the print head is installed, do not touch this lever.

Paper Thickness Lever
Adjusts the gap between the print head and the surface 
of the printing paper.

Print Head Ho
Install the print
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Printer Parts and Their Functions
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Operation Panel

POWER Button
Press to turn the printer 
on or off.

RESUME/CANCEL Button
Press to resume printing once
been resolved. The printer wil
initialise ready for printing.
Also, to cancel printing in prog
this button.

POWER Lamp
Off: the printer is turned off.
Green: the printer is ready to print.
Flashing green: the printer is preparing to print, or is currently printing.
Flashing orange: an error has occurred and the printer is not ready to print
Flashing orange and green alternately: an error has occurred that may 
require a service call.
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Printer Driver Functions (Windows)
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Printer Driver Functions (Windows

• Opening the Printer Properties Dialog Box

• Printer Properties Dialog Box Description

• BJ Status Monitor Functions

• Cancelling a Print Job

• Uninstalling Printer Drivers
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Printer Driver Functions (Windows)
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Opening the Printer Properties 

Opening the Printer Properties Dialog Box

The Printer Properties dialog box can be opened from either within an applica
directly from the Windows Start menu.

■ Opening the Printer Properties dialog box from your application 

This method is generally used to specify printer settings just before printing
The operations may vary slightly depending on your application program. T
describes only the general procedure for opening the Printer Properties dia

1 In your application, select the command to print a document.

The Print dialog box can usually be opened by selecting Print
menu.

2 Ensure that Canon S330 is selected in the Name field. Then 
Properties button.

The Printer Properties dialog box opens. 

Note ➤ Depending on your application program, the command and m
may differ, and there may be more steps involved in opening 
Properties dialog box. For further details, see the user's manu
application. 
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Printer Driver Functions (Windows)
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Opening the Printer Properties 

■ Opening the Printer Properties dialog box directly from the Start

This method is used for maintenance operations such as print head cleanin
specify printer settings common to all application programs.
When the Printer Properties dialog box is opened from the Start menu, ad
appear, including the Details tab. These do not appear when the Printer Pr
dialog box is opened from within an application. 
For further information about these additional tabs, refer to your Windows 
documentation.

1 Click the Start button, then select Settings, Printers.

For Windows XP, click Start and select Control Panel, Printer
Hardware, and then Printers and Faxes.

2 Select the Canon S330 icon.

3 Open the File menu and select:
• Windows 98/Windows Me ➔  Properties
• Windows 2000/Windows XP ➔  Printing Preferences...

The Printer Properties dialog box opens. 
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Printer Driver Functions (Windows)
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Printer Properties Dialog Box D

Printer Properties Dialog Box Description

Note ➤ The screens in this section refer to Windows 98/Windows Me
The equivalent screens for Windows 2000 and Windows XP m
slightly different.

• Main Tab
• Page Setu
• Stamp/Ba

Tab

• Effects Ta
• Profiles Ta

• Maintenan
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Printer Driver Functions (Windows)

elect custom 
Printer Properties Dialog Box D

Main Tab

(1) Media Type 
Ensure this setting matches the type of media loaded in the printer. 

(2) Print Quality 
Select the print quality you require from among the different options. To s
Print quality, select Custom and click the Set... button. 

(6)

(4)

(1)

(2)

(3)

(5)
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Printer Properties Dialog Box D

(3) Colour Adjustment/Color Adjustment 
Select the method of colour adjustment. To make detailed colour adjustm
Manual, then click the Set... button. 

(4) Greyscale Printing/Grayscale Printing 
Select to print a greyscale version of a colour document. 

(5) Preview before printing
Select to check the layout before printing.

(6) Print Advisor... 
Click to start the Print Advisor. 
The Print Advisor simplifies configuration of the printer driver. By having
answer a series of questions, the Printer Advisor automatically configure
driver settings.

Note ➤ To see a description of any item in the Printer Properties dialo
the ? mark then click the desired item. To see a description o
procedures, click the Help button. If the button does not appea
Windows 2000 or Windows XP, click the Start button then se
Programs (or All Programs) - Canon S330 - Guide.
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Printer Driver Functions (Windows)
Printer Properties Dialog Box D

Page Setup Tab

(1) Page Size 
Ensure the correct paper size is selected.

(2)

(1)

(3)

(7)
(8)

(6)

(4)
(5)
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Printer Properties Dialog Box D

(2) Orientation 
Select landscape or portrait printing and ensure it is the same orientatio
application. 

(3) Printing Type 
Select the printing method from among the following.

Normal-size Printing The document is printed according to the origi
dimensions. This setting is usually selected by

Fit to Page Printing The document is automatically resized and pri
a specified page size.

Scaled Printing The document is resized when printed. When 
selected, you can specify the Printer Paper S
Scaling.

Page Layout Printing Pages are reduced and printed so that multiple
pages fit on each printed page.

Booklet Printing The multiple-page document is printed so that
the document fit on each printed page. The prin
automatically. After the document is printed, yo
a booklet by folding and saddle-stitching the d

Poster Printing This enlarges and splits the print image across
sheets of paper. The printed sheets can then b
to make a large poster.

Banner Printing Select this when printing on banner paper.
(4) Borderless Printing 

The image is printed on the entire paper surface, so that no margins are
four sides of the paper. The media types available for Borderless Printing
GP-301/GP-301N, PP-101 and MP-101. For all other media types, the p
may decrease.
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Printer Properties Dialog Box D

(5) Amount of Extension 
When you select Borderless Printing, the sections that extend beyond th
not printed because the image is enlarged to a size slightly larger than th
You can use the slide bar to adjust how much the image extends beyond
is recommended that you normally set the slide bar to the right end. If yo
slide bar to the left to reduce the extension amount, a border may appea

(6) Duplex Printing
The document is printed on both sides of the paper. After printing one si
ejected page over, and print on the other side.

(7) Reverse order 
Prints the document start with the last page. 

(8) Collate 
Select to print multiple copies of the document one copy at a time.
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Printer Driver Functions (Windows)
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Printer Properties Dialog Box D

Stamp/Background Tab

(1) Stamp 
Select the check box and choose the stamp. 

(2) Place stamp over text 
When Stamp is selected, you can select this check box. When selected,
printed over the print data.

(1)

(2)
(3)

(4

(5

(6
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Printer Properties Dialog Box D

(3) Stamp first page only 
When Stamp is selected, you can select this check box. When selected,
printed only on the first page.  

(4) Define Stamp... 
This allows you to create new stamps, or modify details of a selected sta

(5) Background 
Select the check box and choose the background image you wish to use

(6) Background first page only 
When Background is selected, you can select this check box. When se
background image is printed only on the first page. 

(7) Select Background... 
This allows you to register a new background, or to display details of the
you have selected. 
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Printer Driver Functions (Windows)

he check box 
Printer Properties Dialog Box D

Effects Tab

(1) Simulate Illustration 
This function manipulates colour image data with certain effects. Select t
and adjust the brightness of the image with the Contrast slide bar.

(1)

(2)

(5)

(3)

(4)
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Printer Driver Functions (Windows)
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Printer Properties Dialog Box D

(2) Monochrome Effects 
Prints a colour image in a single colour. Select the check box and choos
use a custom colour using Select Colour/Select Color.

(3) Vivid Photo
By using this function, you can reproduce breathtaking sceneries in whic
especially blues and greens, appear even more vibrant. A major feature 
function is its ability to create vivid backgrounds of fields, trees, oceans, a
maintaining the natural skin tones of people that appear in the images.

(4) Image Optimizer 
Improves the contours and smoothes jaggedness that occur when photo
graphic image data is enlarged within an application.

(5) Photo Optimizer PRO 
Optimises the colour of images taken from a digital camera or scanner. I
effective for images affected by colour imbalance and over- or under exp
When printing several images on one page, optimisation is usually appli
image according to its requirements. However, if the image data has bee
manipulated using cut and paste, rotation or other such operations, group
of all images on the one page is recommended. In such cases, select th
Throughout Page check box. 
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Printer Driver Functions (Windows)

tab.
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Printer Properties Dialog Box D

Profiles Tab

(1) Printing Profiles 
This list displays the printing settings currently registered in the Profiles 
The Current Settings profile contains the settings currently specified in
Page Setup, Stamp/Background and Effects tabs. The Default Settin
contains the factory default settings.

(1)

(4)

(2)

(3)

(6)

(5)
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Printer Properties Dialog Box D

(2) Details 
Displays all the printer settings selected in Printing Profiles.

(3) Description 
Displays a description of the printer settings selected in Printing Profile
enter the description when saving the printer settings. 

(4) Add to Profiles... 
Click to save the settings currently specified in the Main, Page Setup, S
Background and Effects tabs. Select Current Settings in the Printing
then click this button. The Add to Profiles... dialog box appears.

(5) Retrieve from Profiles 
Click to activate registered printer settings. The contents of the Main, Pa
Stamp/Background and Effects tabs are changed by selecting the prin
Printing Profiles and then clicking this button.
This button is disabled when Current Settings is selected.

(6) Delete 
Click to delete unwanted printer settings. Select the unwanted item in th
Profiles list and click the Delete button. 
Current Settings and Default Settings cannot be deleted.
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Printer Properties Dialog Box D

Maintenance Tab

(1) Cleaning 
Click to start print head cleaning.

(2) Deep Cleaning 
Click to start print head deep cleaning.
Use this function only if Cleaning has not improved the print quality.

(1)

(2)

(7)

(5)

(10)

(11)

(6)(3)

(4)

(8)

(9)
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Printer Properties Dialog Box D

(3) Print Head Alignment 
Aligns the print head. For details on print head alignment, refer to Quick 

(4) Nozzle Check 
Prints the nozzle check pattern to ensure the print head nozzles are out
normally. For details, refer to “Examining the Nozzle Check Pattern”.

(5) Power Off 
Click to turn the printer off.

(6) Auto Power 
This allows you to turn the printer off when no data is sent to the printer 
period of time, or turn the printer back on again when data is sent to the

(7) Ink Counter Reset 
Resets ink counter to an initial value. Click this if you did not select Yes w
confirmation message of ink tank replacement appeared after installing 
tank.

(8) Low Ink Warning Setting 
Click to set whether to display alerts, such as Low ink warning, or Ink t
replacement.

(9) Custom Settings... 
Click to modify the printer mode. Change the settings in the Custom Se
box and click Send to change printer mode.

(10) Quiet Mode 
Reduces the printing noise. You can also set the times during which the s
is to be used.
However, the effect may be small, depending on the print quality setting.
Quiet Mode, the print speed may become slower than normal. 
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rogress of 
Printer Properties Dialog Box D

(11) Start Status Monitor 
Click to start the BJ Status Monitor, to check the printer status and the p
printing jobs. 
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BJ Status Monitor Functions

The BJ Status Monitor allows you to check the status of the printer. 
If an error occurs, the status monitor indicates the nature of the error and sug
appropriate solution. When the low ink warning is set to be enabled, the status
checks the ink tanks and displays a warning message when the ink is low.

■ Launching the BJ Status Monitor

The BJ Status Monitor launches automatically when data is sent to the prin
launched, the BJ Status Monitor appears as an icon on the Task Bar. 

1 Click the Canon BJ Status Monitor icon on the Task Bar.

The BJ Status Monitor appears.
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, click the 
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Note ➤ To open the BJ Status Monitor when the printer is not printing
Maintenance tab in the Printer Properties dialog box and clic
Status Monitor button.



 Functions 39

Printer Driver Functions (Windows)
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s on screen.
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■ When errors occur

The BJ Status Monitor is automatically displayed when an error occurs, e.g
runs out of paper or paper jams.
In such cases, take the appropriate action as described in the Printer Stat
In Windows 98, Windows Me, click the Guide tab and follow the instruction

Note ➤ For details on the BJ Status Monitor, select the Help menu an
topic of interest.

When paper has run out:
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Printer Driver Functions (Windows)

/CANCEL 
Cancelling 

Cancelling a Print Job

To cancel the current print job, first open the BJ Status Monitor. 

1 Click the Canon BJ Status Monitor icon on the Task Bar.

2 Click Cancel Printing.

Note ➤ If Cancel Printing is greyed out, press the printer's RESUME
button to terminate the print job. 
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Uninstalling Prin

Uninstalling Printer Drivers

Use the Uninstaller to delete any unwanted printer drivers. This allows you to 
files associated with the printer driver at the same time.

1 Click the Start button and select Programs, Canon S330, Un

For Windows XP, click the Start button and select All Program
S330, Uninstall.

2 Click Yes when the confirmation message appears.

3 When all the files have been deleted, click OK.

The deletion of the printer driver is complete.

If a message prompts you to restart your computer, click OK to restart your co

Note ➤ In Windows 98 or Windows Me, you can also start the Uninst
double-clicking on Uninstall in the Canon S330 folder on the
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Printer Driver Functions (Macintos

• Description of Print Settings

• BJ Print Monitor

• Cancelling a Print Job

• Using the Printer with a Network

• Uninstalling Printer Drivers
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Printer Driver Functions (Macintosh)
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Description of Print Settings

• Page Setup Dialog Box

• Printer Utility 
Dialog Box

• Print Dialog Box

• Options Dialog B
• Register Setting

Dialog Box

• Detailed Setting 
Box
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(2)
(7)

(5)

(8)

(6)

(9)
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Description of Pri

Page Setup Dialog Box

The Page Setup dialog box contains settings for the printed page, such as the
print media, and resizing the printed image. To open the Page Setup dialog bo
Page Setup from the File menu in your application program. 

(1) Paper Size 
Select the size of the paper for the print job. To enter the size manually, s
Custom 1 - Custom 3 and click Custom. 

(2) Banner Printing 
Select this check box when printing on banner paper.
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(3) Borderless Printing 
The image is printed on the entire paper surface, so that no margins are
four sides of the paper. The media types available for Borderless Printing
GP-301/GP-301N, PP-101 and MP-101. For all other media types, the p
may decrease.

(4) Amount of Extension 
When you select Borderless Printing, the sections that extend beyond th
not printed because the image is enlarged to a size slightly larger than th
You can use the slide bar to adjust how much the image extends beyond
is recommended that you normally set the slide bar to the right end. If yo
slide bar to the left to reduce the extension amount, a border may appea

(5) Scale 
Specify the scaling percentage to resize the document for printing.

(6) Orientation 
Select landscape or portrait printing. 

(7) Custom 
To specify a custom paper size, click this button to open the Custom dia
selecting Custom 1 to Custom 3 in the Paper Size popup menu. The Cu
Box allows you to specify the length and width of the paper.

(8) Utilities 
Click to open the Printer Utility dialog box for maintenance operations s
head cleaning and nozzle check pattern printing, as well as for changing
mode. 

(9) Save Settings 
Saves the settings specified in the Page Setup dialog box.
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Printer Utility Dialog Box

The Printer Utility dialog box is displayed when you click the Utilities button 
Setup dialog box.

(1) Select the function you wish to perform: Cleaning, Test Print, Remaining
setting, Auto Power, Quiet Mode or Custom Settings.

(2) Display area showing the various maintenance functions, including clean
pattern printing. Click the icon to start this function. For further details, re
"Routine Maintenance". 

(1)

(2)
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 Start Guide. 
Description of Pri

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

➡ Print Head Deep Cleaning

➡ How Low Ink Warning Setting Works

Note ➤ For information about Print Head Alignment, refer to the Quick
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Print Dialog Box

The Print dialog box specifies the media type and print settings to be used fo
job. To open the Print dialog box, select Print from the File menu in your app
program. 

(1) Options... 
Specify the output destination, print order and page layout for the docum
printing. 

(2) Apply... 
Allows you to register print settings or to implement a previously register
setting. 

(3) Media Type 
Ensure this setting matches the type of paper media loaded in the printe

(1)
(2)

(3)

(4)

(5)(6)
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(4) Details... 
Allows you to manually set the print quality and colour settings in the De
Dialog Box.

(5) Print Mode 
Select the option in accordance with the document type and printing pur

(6) Greyscale Printing/Grayscale Printing 
Select to print a greyscale version of a colour document.
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Detailed Setting Dialog Box

To open the Detailed Setting dialog box, select Manual from Print Mode, the
Details.

■ Quality panel

(1) Panel display icons
Click these icons to switch between panels in the Detailed Setting dialo

(1)
(2)

(3)
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(2) Print Quality 
Move the slide bar to adjust the balance between print quality and speed
bar to the right enhances print quality, and moving it to the left increases
speed.

(3) Halftoning 
Select either Dither or Diffusion ink dot configurations. 
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(2)

(3)

(4)
Description of Pri

■ Special Effects Panel

To display the Special Effects panel, click the Special effects display icon. 

(1) Simulate illustration 
This function manipulates colour image with certain effects. Select the c
adjust the brightness of the image with the Contrast slide bar.
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(2) Monochrome effects 
Prints a colour image in a single colour. Select the check box and choos
use a custom colour using Select Colour/Select Color.

(3) Vivid Photo
By using this function, you can reproduce breathtaking sceneries in whic
especially blues and greens, appear even more vibrant. A major feature 
function is its ability to create vivid backgrounds of fields, trees, oceans, a
maintaining the natural skin tones of people that appear in the images.

(4) Photo Optimizer PRO
Optimises the colour of images taken from a digital camera or scanner. I
effective for images affected by colour imbalance and over- or under exp
When printing several images on one printing page, optimisation is usua
each image according to its requirements. However, if the image data ha
manipulated using cut and paste, rotation or other such operations, group
of all images on the page is recommended. In such cases, select the  Ap
Throughout Page check box. 
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■ Colour/Color Panel

To display the Colour/Color panel, click the Colour/Color display icon. 

(1) Colour Correction/Color Correction
Select a colour correction method: BJ Standard, ColorSync or None. B
is usually the optimum colour correction method for printing with a BJ pr
ColorSync is selected, you should also specify the Print Type and Prin
settings.

(1)
(2)
(3)
(4)

(5)

(6)
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(2) Print Type 
For printing that emphasises intermediate colours, select Photo. For prin
emphasises the brightness of primary colours, select Graphics. For doc
contain large amounts of a basic colour, select Spot Colour/Spot Color

(3) Printer Profile 
Select optimised colour characteristics (a profile) for the media type and

(4) Gamma Correction 
This function adjusts the colour contrast (not including pure black and wh
the contrast, select the check box and move the slide bar. Moving the ba
darkens the entire image while increasing contrast in the lighter areas an
contrast in the darker areas.

(5) Colour Balance/Color Balance
Move the bar for each colour to adjust the balance of colour intensity. Mo
to the right intensifies the colour.

(6) Intensity 
Move the slide bar to adjust the print density. Moving the bar to the right 
density. 
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(1)

(2)

(5)
(6)

(3)
Description of Pri

Options Dialog Box

To open the Options dialog box, click the Options... button in the Print dialog

(1) Layout 
Use this function to print more than one page on a single sheet of paper.
setting is set to display 1 Page/Sheet Printing. If another option is selec
Order and Border can be specified.

(4)
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2 Page/Sheet Printing/4 Page/Sheet Printing
Pages are reduced and printed so that two or four pages fit on each p
You can also select page order and whether to place a border around

Poster (Divided into 4) / (Divided into 9) / (Divided into 16) 
These enlarge and split the print image across several sheets of pape
sheets can then be assembled to make a large poster. You can also s
Paste lines and Cut/Paste string. To print only the certain pages, clic
pages on the preview area.

(2) Duplex Printing
The document is printed on both sides of the paper. After printing one si
ejected page over, and print on the other side.

(3) Fit-to-page Printing 
Executes the scaled printing automatically. When selected, you can spec
Printer Paper Size
Fits the document paper size set in the application to the paper size load
printer.

(4) Destination 
Select the print output destination. Printer is the usual selection. 
To check the layout or other image elements before printing, select Prev
the document as a PICT file, select PICT File.

(5) Print in reverse order 
Prints the document starting with the last page. 

(6) Print collated pages 
Prints multiple copies of the document one copy at a time. 
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Register Settings Dialog Box

To open the Register Settings dialog box, click the Apply... button in the Prin

(1) Settings 
Displays a list of the registered print settings.

(2) Defaults 
Restores the print settings selected in Settings to defaults. A check mar
next to the selected print settings.

(3) Import 
Imports a set of print settings. To use the settings, select the desired set
Settings list and click the Import button.

(4) Apply 
Saves the settings currently specified in the Print dialog box. After clickin
enter the name under which the settings are to be saved. 

(5) Remove 
Deletes unwanted print settings. To delete unwanted settings, select the
Settings and click the Remove button. 

(1)

(4)
(5)

(2)

(3)
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BJ Print Monitor

The BJ Print Monitor allows you to check the progress of print jobs. 
You can launch the BJ Print Monitor if background printing is enabled in the C

■ Opening the BJ Print Monitor

1 Select Chooser from the Apple Menu.

2 Set Backgrounding to On.

3 After starting a print job, select BJ Print Monitor in the Applic

The BJ Print Monitor launches.
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■ BJ Print Monitor Functions

The BJ Print Monitor allows you to change the print order of documents queue
To change the print order, place the mouse pointer over the name of the docum
mouse button down while dragging the document name to the new position, t
When the print order change includes the current job, it stops and the new job
starts instead.

 ... Click to pause printing of the specified document.

 ... Click to resume printing.

 ... Click to cancel printing of the specified document.

Displays the printer status. If an error occurs, instructions on what to 
do are displayed.
Displays the printer status and ink status with images.

Displays information about the documents queued for printing. 
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Cancelling a Print Job

When the BJ Print Monitor is running, you can use it to cancel or suspend the
job.

1 Select BJ Print Monitor in the Application Menu. 

2 Click the name of the print job you wish to cancel, then click 

The document selected in the Print Monitor is deleted from the
the print job is cancelled. 

Note ➤ To suspend printing, click the name of the document being pr
click . To resume printing, click . 
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Using the Printer with a Network

The printer can be used with an Ethernet network environment. Follow the ste
below to connect the printer to the network. 

■ Before Setting up the Printer

Install the printer driver on each network computer that will use the printer.
For information on installation, refer to the Quick Start Guide.

■ Printer Setup

To use the printer on a network, first set up the print server, then set up eac
machine.

• Print server setup procedure

1 Select Chooser in the Apple Menu.

2 Select Active in AppleTalk.

3 Select the S330 icon, then select the printer name in Connec
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4 Click Share.

5 Confirm that S330 server is selected in Enter new print serv
then click Send. 

6 Confirm that the new print server name has been added to C
servers then click Close.

7 Click the close box to close the Chooser.

• Client setup procedure

1 Select Chooser in the Apple Menu.

2 Select Active in AppleTalk.

3 Select the S330 (Server) icon, then select the printer server i
to:.

4 Click the close box to close the Chooser.
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■ Checking Print Status

• Checking print status from the print server
To check the status of a print job from the print server, start the BJ Print 
Select BJ Print Monitor in the Application Menu.
To close the BJ Print Monitor, select Close Status Window in the File m

• Checking print status from a client
To check the status of a print job from a client, start the BJ Status Monitor
Status Monitor icon in the BJ Extras folder.
To close the BJ Status Monitor, select Quit in the File menu.

• The BJ Print Monitor and BJ Status Monitor
The BJ Print Monitor and the BJ Status Monitor both display a list of info
concerning documents queued for printing. This information includes the
name, number of pages, number of copies and the time when the print j
accepted. The total number of queued documents is also displayed. 
The BJ Print Monitor allows you to change the print order of the queued

➡ BJ Print Monitor Functions

➡ BJ Status Monitor Functions
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■ BJ Status Monitor Functions

....Click to pause printing of the specified document. 

....Click to resume printing. 

....Click to cancel printing of the specified document.

Note ➤ • You can determine the owner of a computer by selecting the
control panel and checking the Owner Name item.

• If you are using two or more printer servers, you can switch 
BJ Status Monitor displays. Select Print Server in the File m
select the desired print server and click OK.
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Uninstalling Printer Drivers

When a printer driver is no longer needed, use the Installer to delete, all the p
associated with it at the same time.

Before proceeding, ensure you save any unsaved files in any currently running

1 Load the Setup Software & User's Guide CD-ROM.

2 Double-click the Printer Driver folder.

3 Double-click the Installer icon.

4 When the Software License Agreement is displayed, click Ac

5 Select Uninstall from the popup menu and then click Uninsta

Note ➤ If a warning message appears indicating that other applicatio
running:
• Click Cancel and save the document(s) if there are any uns

documents open in the other applications.
• Click Continue to continue the uninstall operation.

6 After the uninstall is complete, a message appears prompting 
your computer. Click Restart. 
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Routine Maintenance

• When to Replace Ink Tank and Maintain Print Head

• Replacing an Ink Tank

• Resetting the Ink Counter

• How Low Ink Warning Setting Works

• Printing the Nozzle Check Pattern

• Print Head Cleaning

• Print Head Deep Cleaning

• How Low Ink Warning Setting Works

• Transporting the Printer
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When to Replace Ink Tank and Maintain Print He

When printing becomes faint or colours are incorrect, see if the print head noz
clogged and clean them first. Follow the procedures below and replace an ink
necessary.

➡ Printing the Nozzle Check Pattern

If the print quality is poor

➡ Print Head Cleaning

If the problem remains

➡ Print Head Deep Cleaning

Still the problem remains

➡ Replacing an Ink Tank

If ink tank replacement does not resolve the problem, the print head may be w
Contact a Canon service representative.



n Ink Tank 69

Routine Maintenance

r will not print 

y the Canon 
anks to 
Replacing a

Replacing an Ink Tank

When replacing an ink tank, check the model number very carefully. The printe
properly if the wrong ink tank is used, or installed in the incorrect position.

• Black: BCI-24 Black
• Colour: BCI-24 Color

Note ➤ Damage caused by using a refilled cartridge is not covered b
warranty. Canon recommends using only original Canon ink t
ensure the best quality.

1 Ensure that the printer is on, and then open the front cover.

The print head holder moves to the left.
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2 Remove the empty ink tank.

Pull the tab on the ink tank towards you to release.

Then lift it from its slot.

Do not touch the lock lever; remove only the ink tank.

Important ➤ • Handle ink tanks carefully to avoid staining clothing or the s
area.

• Discard empty ink tanks according to the local laws and reg
regarding disposal of consumables.

colour black
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3 Unpack a new ink tank and remove the orange protective cap

Important ➤ • Do not re-attach the protective cap once you have removed
• Once you have removed the protective cap, do not touch the

port. 
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4 Insert the ink tank into a slot.
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5 Press on the tab until the ink tank snaps firmly into place.

6 Close the front cover.

The print head holder moves to the right. The ink tank installa
is now complete.

Note ➤ • To maintain optimal print quality, use an ink tank within six m
use.

• Once an ink tank has been used, do not remove it from the 
leave it out in the open. This will cause the ink tank to dry ou
printer may not function properly if it is reinstalled.

• Reset the ink counter every time you replace the ink tank.

➡ Resetting the Ink Counter
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Resetting the Ink Counter

When an ink tank is replaced, the ink counter must be reset. The low ink warn
displayed properly if the ink counter is reset.

➡ How Low Ink Warning Setting Works

■ Ink Counter Reset

When the front cover has been open for a certain period, a confirmation mess
tank replacement is displayed before the next print job.

Windows

1 Check the message, and click Yes.

2 Select the replaced ink tank, and click OK.

Note ➤ When both black and colour ink tanks have been replaced, se
Black and Colour.
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Macintosh

1 Check the message, and click Yes.

2 Select the replaced ink tank, and click OK.

Note ➤ When both black and colour ink tanks have been replaced, se
Black and Colour.

■ Resetting the ink counter from the printer driver setting screen

Note ➤ Do not reset an ink counter of an ink tank already in use.

Windows

1 Ensure the printer is on and open the Printer Properties dialo

➡ Opening the Printer Properties Dialog Box

2 On the Maintenance tab, click Ink Counter Reset icon.

3 Select the ink tank you have just installed and click Execute.
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Macintosh

1 Ensure the printer is on and open the Page Setup dialog box

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

2 Click Utilities icon to open the Printer Utility dialog box.

3 Select Remaining ink level setting from the pull-down menu
Counter Reset.

4 Select the ink tank you have just installed and click Execute.
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How Low Ink Warning Setting Works

The low ink warning notifies you of low ink levels during printing. The Low Ink 
been preset to be automatically displayed.

Note ➤ Refer to “Modifying the low ink warning setting” to change the
do not want to display the Low Ink Warning.

■ What is Low Ink Warning?

Reset the ink counter of the ink tank installe

When ink becomes low...

The low ink warning alerts.

When you install a new ink tan

When you reset the ink counter, it will assume the ink tank is full regardless of 
actually remains. The reset is the only way to match the counter value with an
volume. Reset the ink counter when installing a new ink tank.

➡ How to Display Low Ink Warning Correctly



ting Works 78

Routine Maintenance

olour ink 
es low.
How Low Ink Warning Set

■ Low Ink Warning Display

The '!' shows a low ink level in the ink tank.

BJ Status Monitor (Windows)

BJ Status Dialog (Macintosh)

The c
becom

The colour ink 
becomes low.
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Macintosh

Note ➤ When the background printing is enabled, the low ink warning
on the BJ Print Monitor (Macintosh).

➡ BJ Print Monitor

■ How to Display Low Ink Warning Correctly

• Reset the ink counter every time you install a new ink tank
The ink counter cannot work correctly unless you synchronise it with the
level.  The ink counter can only be adjusted when it is reset at the time a
is installed.

• Do not reset the ink counter of an ink tank in use.
Synchronisation of the counter and the actual ink level will not work prop

Note ➤ • If you did not reset the counter when you installed the curre
the low ink warning may not function correctly, until the next
replace the ink tanks.  Also, ensure you treat both counters 

• Refer to 'Low Ink Warning Displays Ink Tank with '?'' as it is 

■ Setting Low Ink Warning

Note ➤ Reset the ink counter every time installing a new ink tank whe
warning is enabled.  Otherwise the ink levels will not be displa
accurately.
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• Modifying the low ink warning setting

Windows

1 Ensure the printer is on and open the Printer Properties dialo

➡ Opening the Printer Properties Dialog Box

2 On the Maintenance tab, click Low Ink Warning Setting icon

3 Modify the Display low ink warning and Display a confirma
message of ink tank replacement settings, and click Send.

Macintosh

1 Ensure the printer is on and open the Page Setup dialog box

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

2 Click Utilities icon to open the Printer Utility dialog box.

3 Select Low Ink Warning from the pull-down menu and click t
Remaining ink level setting icon.
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4 Modify the Display low ink warning and Display a confirma
message of ink tank replacement settings, and click Send.
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects normally fr
head nozzles, and to verify print head alignment. Use this function when printe
blurred or the colour is incorrect.

Nozzle check pattern printing can be executed from the Windows and Macinto
drivers, or from the printer itself.

■ Printing the Nozzle Check Pattern from the Printer Drivers

Windows

1 With the printer on, load a sheet of A4 or Letter paper in the p

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab and then click the Nozzle Check icon.

4 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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Macintosh

1 With the printer on, load a sheet of A4 or Letter paper in the p

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

3 Click the Utilities button to open the Printer Utilities dialog bo

4 Select Test Print from the pull-down menu, and then click the
Check icon.

5 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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■ Printing the Nozzle Check Pattern through the Printer

1 With the printer on, load a sheet of A4 or Letter paper in the p

2 Hold the RESUME/CANCEL button down until the POWER la
twice.

➡ Examining the Nozzle Check Pattern
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■ Examining the Nozzle Check Pattern

The nozzle check pattern should appear as follows when ink is discharged pr
Examine the nozzle check pattern output by the printer.

K

C

M

Y

Lines missing here indi
print head requires clea

Unevenness in these p
indicates the print head
alignment.
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Print Head Cleaning

Clean the print head if you suspect that the nozzles might be clogged.
Head cleaning can be performed either from the printer drivers or from the pr

Note ➤ Cleaning the head consumes ink, so perform head cleaning o
necessary.

■ Cleaning the Print Head from the Printer Drivers

Windows

1 Ensure that the printer is on.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab and then click the Cleaning icon.
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4 Select the ink nozzles to be cleaned, and then click Execute.

All colours/All colors: All nozzles
Black: Black ink nozzles
Colour/Color: Colour ink nozzles

5 When a confirmation message is displayed, click OK.

Macintosh

1 Ensure the printer is on.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

3 Click the Utilities button to open the Printer Utility dialog box.

4 Select Cleaning from the pull-down menu, and then click the
icon.
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5 Select the ink nozzles to be cleaned, and then click OK.

All colours/All colors: All nozzles
Black: Black ink nozzles
Colour/Color: Colour ink nozzles

■ Cleaning the Print Head from the Printer

This operation cleans all nozzles, both black and colour. Because this method
the printer, any print data stored in the printer is lost.

1 Ensure the printer is on.

2 Hold down the RESUME/CANCEL button until the POWER la
once.

Now the POWER lamp starts flashing and print head cleaning begins. Do not
other operations until the head cleaning finishes. This takes about 50 seconds
After print head cleaning finishes, print the nozzle check pattern to verify that t
nozzles are clean.

➡ Printing the Nozzle Check Pattern
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Print Head Deep Cleaning

If print quality does not improve by standard print head cleaning, try deep clea
a more powerful process. Perform print head deep cleaning from the printer d

Note ➤ Print head deep cleaning consumes ink, so perform this proc
when necessary.

Windows

1 Ensure the printer is on.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab and then click the Deep Cleaning icon

4 When the confirmation message is displayed, click OK.
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Macintosh

1 Ensure the printer is on.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

3 Click the Utilities button to open the Printer Utility dialog box.

4 Select Cleaning from the pull-down menu, and then click the
Cleaning icon.

5 Click OK.

Now the POWER lamp starts flashing and print head deep cleaning begins. T
takes one or two minutes to complete, so simply wait until the POWER lamp s
After print head deep cleaning finishes, print the nozzle check pattern to verify
is clean. If not, perform print head deep cleaning once more. If the head is stil
after the second deep cleaning, the print head may be worn out, even if ink re
ink tanks. In this event, contact a Canon service representative.

➡ Printing the Nozzle Check Pattern
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Transporting the Printer

Pack the printer carefully in its original packing materials.

If you do not have the original packing materials, pack the printer carefully and
protective material inside of a sturdy box.

1 Turn the printer off.

2 After making sure that the POWER lamp is off, unplug the pri

Important ➤ Do not unplug the printer while the POWER lamp is lit or flash
the printer from damage.
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3 Remove the paper rest and the paper output tray.

4 Disconnect the printer cable from the computer and from the 
then disconnect the power cord from the printer.
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5 Secure the printer with adhesive tape as shown, and then pac
plastic bag.
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6 Attach protective material to both sides of the printer when pa
printer.

Clearly label the box as "Fragile", if using a transport compan
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• Compatible Media Types

• Envelopes

• High Resolution Paper HR-101N

• Glossy Photo Paper GP-301N/GP-301

• High Gloss Photo Film HG-201

• Glossy Photo Cards FM-101

• Photo Paper Pro PR-101

• Photo Paper Pro PC-101S

• Transparencies CF-102

• T-Shirt Transfers TR-201

• Banner Paper
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Compatible Media Types

You can use the following types of paper and other media.

■ Size

• Standard paper: From A5 size (148.0 x 210.0 mm / 5.83 x 8.27 in) to legal s
355.6 mm / 8.5 x 14.0 in)

• Non-standard paper: From 90.0 x 120.0 mm to 215.9 x 584.2 mm
                                  (From 3.54 x 4.72 in  to  8.5 x 23.0 in)

• Others: Envelopes (European DL and US Com. #10)

Important ➤ Do not use the following types of paper. Using such paper will 
produce unsatisfactory results, but can also cause the printer t
malfunction.
• Folded, curled or wrinkled paper
• Wet paper
• Paper that is too thin *(less than 64 g/m2 / 17 lb)
• Paper that is too thick (more than 105 g/m2 / 28 lb)
• Picture postcards
• Postcards with an affixed photo or sticker
• Envelopes with a double flap
• Sealed envelopes
• Envelopes with an embossed or treated surface 
• Paper with holes (such as loose-leaf paper)

*non-Canon branded paper
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■ Weight

64 to 105 g/m2 (17 to 28 lb)
Do not use paper heavier than this (except for supported Canon-brand me
could jam in the printer.

■ Types

The following types of media can be used.
For more information about the media and the printing methods, refer to th
sections.

Plain paper: Refer to the Quick Start Guide.

➡ Envelopes

➡ High Resolution Paper HR-101N

➡ Glossy Photo Paper GP-301N/GP-301

➡ High Gloss Photo Film HG-201

➡ Glossy Photo Cards FM-101

➡ Photo Paper Pro PR-101

➡ Photo Paper Pro PC-101S

➡ Transparencies CF-102

➡ T-Shirt Transfers TR-201

➡ Banner Paper
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 flatten them 

ntly bend 
Envelopes

Use either European DL or US Com. #10 size envelopes.

■ Preparation for Printing

1 Press down on all four corners and edges of the envelopes to
as shown below.

2 If the envelopes are curled, hold the opposite corners and ge
them in the opposite direction.

Ensure that the flap of the envelope is perfectly straight.
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Printing Media
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ly flat and the 

pletely flat, 
 to the edge.

f the 
3 If the leading edge of an envelope is puffed up or curled, use a
the envelope flat and sharpen the crease.

The envelopes may jam in the printer if they are not complete
edges are not aligned.

Ensure that no curl or puff exceeds 3 mm (0.1 in).

■ Unsuitable Envelopes

• Envelopes with an embossed or treated surface 
• Envelopes with a double flap or pressure seals

Press the envelope com
working from the middle

* The above illustrations show a side view of the leading edge o
envelope.
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d in the 

 the POWER 
■ Loading

• Place envelopes lengthwise with the flap to the left and the address side 
upwards.

• Set the paper thickness lever to the right.
• Up to 10 envelopes can be loaded at once.

Note ➤ If the envelopes still do not feed properly even after removing
the paper feed roller.

1 Ensure the printer is on and there is not any paper loade
printer.

2 Hold the RESUME/CANCEL button down and release as
lamp flashes three times.

Paper thickness lever



Envelopes 101

Printing Media

er.

 the POWER 

fter the 

pe size you 
The paper roller starts rotating ten times as it cleans.
Repeat this three times.

3 Load a sheet of A4 or Letter sized plain paper in the print

4 Hold the RESUME/CANCEL button down and release as
lamp flashes three times to feed the sheet.
Repeat this three times.

If the printer still does not feed the envelopes through even a
cleaning, repeat Step 4 again.

■ Printer Driver Settings

• Media Type: Envelope
• Page Size: Select either DL Env. or #10 Env. according to the envelo

are using
• Orientation: Landscape

■ Handling of Printed Output

Remove each envelope as it is printed.

■ Printable Area

➡ Printing Area
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High Resolution Pape

High Resolution Paper HR-101N

This type of paper provides better colour reproduction than plain paper. It is s
printing business documents that feature graphics, and for photographs.

■ Loading

• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.
• Do not load paper higher than the limit mark. A maximum of 80 sheets ca

Paper thickness lever

Print side
(Whiter si
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High Resolution Pape

■ Printer Driver Settings

• Media Type: High Resolution Paper
• Page Size: Ensure the setting matches the size set in the application

■ Handling of Printed Output

Do not stack more than 50 sheets in the paper output tray. If the output pap
may prevent the next sheet being ejected. In this case, or if the ink takes a 
dry, remove each sheet as soon as it is printed.

■ Printable Area

➡ Printing Area
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Glossy Photo Paper GP-301

Glossy Photo Paper GP-301N/GP-301

This media is still thicker than High Resolution Paper with a glossy printing su
produce print-outs close to photograph quality.

■ Loading

• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.
• A maximum of 10 sheets can be loaded at once.
• When printing on Glossy Photo Paper GP-301, do not use any loading su

Paper thickness lever

Print side
(Whiter side
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Glossy Photo Paper GP-301

■ Printer Driver Settings

• Media Type: Glossy Photo Paper
• Page Size: Ensure the setting matches the size set in the application

■ Handling of Printed Output

• Do not stack more than 10 sheets in the paper output tray.
• Do not touch the printed surface until the ink is fixed (approx. two minutes

■ Printable Area

➡ Printing Area

Note ➤ For photograph and illustration data that you want to print wit
Printing, create the data by using the same size as the paper
paste the data so that it fills the editing screen without leaving
If you are using an application that allows you to set margins,
right, top and bottom margins to 0 mm. For instructions on se
refer to the user's manual for your application.
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High Gloss Photo Film HG-201

This film has an extremely glossy surface, ideal for printing photographs with 
results.

■ Loading

• Load only one sheet at a time.
• Load the film with the cut corner at the upper right.
• If the film is curled, flatten it by curling in the opposite direction.
• Set the paper thickness lever to the left.

Paper thickness lever
C
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Printing Media
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High Gloss Photo Fi

■ Printer Driver Settings

• Media Type: High Gloss Photo Film
• Page Size: Ensure the setting matches the size set in the application

■ Handling of Printed Output

• Remove each sheet as soon as it is printed.
• Do not touch the printed surface until the ink is fixed.

■ Printable Area

➡ Printing Area
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Glossy Photo Cards FM-101

Made of the same material as Glossy Photo Paper GP-301, this photo-size pa
intended for printing images that cover the entire surface of the card, without a
When printing, use the original application software, Easy-PhotoPrint (for Win
ImageBrowser (for Macintosh).

■ Loading

• Load the paper with the glossy side facing up.
• Set the Paper Thickness Lever to the left.
• A maximum of 20 sheets can be loaded at once.
• Do not use the loading support sheet provided with the package.

Paper Thickness Lever

Print side
(Glossy side)
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Glossy Photo Car

■ Handling of Printed Output

• Do not stack more than 20 sheets in the paper output tray.
• Do not touch the printed surface until the ink is fixed (approx. two minutes
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Photo Paper Pro PR-101

This is thick paper with a treated surface that enhances gloss and provides su
reproduction. It is ideal for printing high quality photographs. This media is ava
Letter and 4 x 6 sizes.

■ Loading

• Load only one sheet at a time.
• Load the paper with the glossier side facing up.
• Set the paper thickness lever to the left.

Paper thickness lever

Print sid
(Glossie
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Photo Paper P

■ Printer Driver Settings

• MediaType: Photo Paper Pro
• Page Size: Ensure the setting matches the size set in the application

■ Handling of Printed Output

• Remove each sheet as soon as it is printed. 
• Do not stack more than 20 sheets of 4 x 6 size paper in the output tray.
• Do not touch the printed surface until the ink is fixed (approx. 30 minutes)

Colours in dark images may appear indistinct at first, but become clearer a
minutes.

• Images may smudge if you place them in an album before the ink is comp
recommended that you allow the ink to dry for 24 hours.

• Do not attempt to dry the ink with a hair dryer or by exposing printed shee
sunlight.

■ Storing Printed Output

• Do not store or display printouts in hot, damp or humid conditions.
Never expose them to heat or direct sunlight.

• Store printouts in photo albums, photo frames or presentation binders to 
from direct exposure to air or sunlight.

• Do not mount printouts in an adhesive-type album, as you may not be ab
them.
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Photo Paper P

• Be aware that some types of clear plastic folders and albums may cause 
the paper to turn yellow.

■ Printable Area

➡ Printing Area

Note ➤ For photograph and illustration data that you want to print wit
Printing, create the data by using the same size as the paper
paste the data so that it fills the editing screen without leaving
If you are using an application that allows you to set margins,
right, top and bottom margins to 0 mm. For instructions on se
refer to the user's manual for your application.
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Photo Paper Pro PC-101S

Made of the same material as Photo Paper Pro PR-101, this photo-size pape
for printing images that cover the entire surface of the card, without a white bo
printing, use the original application software, Easy-PhotoPrint (for Windows) or I
(for Macintosh).

■ Loading

• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.
• A maximum of 20 sheets can be loaded at once.

Print side
(Glossy side

Paper thickness lever
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Printing Media
Photo Paper Pr

■ Handling of Printed Output

Follow the instructions described in "Photo Paper Pro PR-101".
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Transparencies CF-102

This film is ideal for printing presentation material for use with overhead proje

■ Loading

• Place one sheet of plain A4 or Letter paper under the transparencies in th
feeder.

• Set the paper thickness lever to the left.
• A maximum of 30 sheets can be loaded at once.

Paper thickness lever

Plai

Transpare
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Transparenc

• Although you can print on either side of CF-102, best results can be obta
printing on the side toward which it curls when held by the edge.

■ Printer Driver Settings

• Media Type: Transparency
• Page Size: Ensure the setting matches the size set in the application

■ Handling of Printed Output

• Remove each transparency as soon as it is printed.
• Do not touch the printed surface until the ink is fixed (approx. 15 minutes)

■ Printable Area

➡ Printing Area

Print side
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T-Shirt Transfers TR-201

This paper is used to produce iron-on transfers. The image is printed backwar
Media Type is set to T-Shirt Transfer in the printer driver.

Note ➤ For the customers in the United States, refer to the Quick Sta
instructions on using TR-101 T-shirt transfers.

■ Loading

• Load only one sheet at a time.
• If the T-shirt transfer is curled, flatten it by curling it in the opposite directio
• Load the paper with the side that does not have green lines facing up.
• Set the paper thickness lever to the right.

Paper thickness lever
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■ Printer Driver Settings

• Media Type: T-Shirt Transfer
• Page Size: Ensure the setting matches the size set in the application

■ Handling of Printed Output

• Remove each T-shirt transfer as soon as it is printed.
• The T-shirt transfer should be used as soon as possible. Refer to the supp

instructions for details on how to use the paper.

■ Printable Area

➡ Printing Area
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Banner Paper

This is long paper that consists of consecutive sheets of A4 or Letter size pap
printing long posters or banners (up to six sheets long).

■ Preparation for Printing

• When tearing the banner paper, tear off one more sheet than you actually
• The maximum length for one print job is six sheets, so if you will be printin

sheets, tear off a seven-sheet length.

■ Loading

1 Set the Paper Thickness Lever to the right.

2 Load the banner paper with the printing side facing up. Gently
perforation between the first and second sheets.

Leave the rest of the paper folded up.
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3 Place the printer where the printed banner output can hang o
of the table.

Ensure the ink does not stain the table or floor.



nner Paper 121

Printing Media

anner 
Ba

■ Printer Driver Settings

• Media Type: Plain Paper
• Page Size: When using A4 banner paper: A4

When using letter size banner paper: Letter
• Printing Type: Banner Printing

On a Macintosh, before creating the document, select B
Printing in the Page Setup dialog box.

• Copies: Must be set to "1" to print correctly. 

■ Printable Area

➡ Printing Area
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Troubleshooting

• Cannot Install the Printer Driver

• Print Quality is Poor or Contains Errors

• Printer Does Not Start or Stops During Print Jobs

• Paper Does Not Feed Properly or Paper Jams

• The POWER Lamp Flashes Orange

• An Error Message is Displayed on the Screen

• Have you replaced an ink tank with a new one? is Displayed

• Low Ink Warning Displays Ink Tank with '?'

• Problems Unique to Windows 

• Problems Unique to the Macintosh 

Windows

Macintosh
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Cannot Install the Pr

Cannot Install the Printer Driver

■ Follow the installation procedure correctly.

Install the printer driver carefully following the procedures described in the 
Guide.

If the printer driver was not installed correctly, reinstall it. If you are using W
delete the printer driver before reinstalling it.

➡ Uninstalling Printer Drivers

Note ➤ If the Installer was forcibly terminated due to an error in Windo
may be unstable and this will prevent the printer driver from be
Restart the computer before reinstalling the printer driver.

■ Close any other applications before installation.

Sometimes the printer driver cannot be installed because another applicati
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Cannot Install the Pr

■ If the Installer for the printer driver does not start up automatically whe
the Setup Software & User’s Guide CD-ROM, open the My Computer w
then double-click the CD-ROM icon. 

Note ➤ If you are typing in the file name, you must specify the CD-RO
and the installation program ("MSetup.exe"). The CD-ROM d
computer dependent.

■ Confirm that there are no problems with the Setup Software & User’s 
ROM.

In Windows, use Explorer to ensure that the CD-ROM can be read. In a Ma
check that the CD-ROM icon is visible. If there is a problem with the CD-RO
Canon service representative.

Windows
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Troubleshooting
Print Quality is Poor or Cont

Print Quality is Poor or Contains Errors

• Cannot Print to End of Job

• Colours are Unclear

• Meaningless Characters or Symbols are Printed

• Printing is Blurred/Colours are Wrong

• Straight Lines are Misaligned

• Printed Paper Curls or Ink Blots

• Back of Paper is Smudged

• Printed Surface is Scratched

• White Streaks

• Colours are Uneven or Streaked
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Cannot Print to End of Job

■ Confirm the Page Size setting matches the size of the paper loaded in

First, check the Page Size setting in the application.

Then check the Page Size setting in the Printer Properties dialog box for W
Page Setup dialog box for Macintosh.

■ Check the amount of the free space on the hard disk.

You may need to increase the amount of free space by deleting any unnec
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Colours are Unclear

■ Confirm the Media Type setting in the printer driver matches the type 
loaded in the printer.

If you are printing a photograph or an illustration from a Windows enviro
increase Print Quality on the Main tab.
If you are working in a Macintosh environment, select Photo or Graphic
Mode in the Print dialog box.

■ Confirm the specified ink tank is installed.

When an ink tank runs out of ink, replace it with a new one.

Note ➤ Printed colours may not match screen colours perfectly due t
differences in the methods used to produce colours. Colour co
and environmental differences can also affect how colours ap
screen.
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Meaningless Characters or Symbols are Printed

■ If the problem only occurs when printing a specific document, try edit
document and then printing it.

If this does not resolve the problem, there may be a problem with your app
program. 
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Printing is Blurred/Colours are Wrong

■ Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the print head.

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

If the problem is not resolved after cleaning the print head several times, rep
ink tanks. If print quality still remains poor, the print head may be worn out.
Canon service representative.

Note ➤ Always ensure you dispose of the protective cap from a print 

■ Ensure you are printing on the correct side of the media.

You can only print on one side of certain media. 
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Print Quality is Poor or Cont

Straight Lines are Misaligned

■ Align the print head.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab.

3 Click Print Head Alignment.

Follow the instructions on the screen.
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Print Quality is Poor or Cont

Macintosh

1 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

2 Click Utilities.

3 Select Test Print from the pull-down menu, and then click Pri
Alignment.

Follow the instructions on the screen.

Note ➤ Straight lines can become misaligned if the paper thickness le
moved. Aligning the print head may also resolve this problem
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Print Quality is Poor or Cont

■ In the printer driver settings, select a higher print quality setting.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Pri
menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Quality icon and then drag the Print Quality slide b
end.
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Printed Paper Curls or Ink Blots

■ Use high resolution paper or photo paper to print images that require
(i.e. pictures with intense colours or photographs).

■ Reduce the Intensity setting in the printer driver and try printing again

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Manual for Colour Adjustment/Colo
Adjustment, and then click Set.

3 Drag the Intensity slide bar to adjust the intensity.
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Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Pri
menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Colour/Color icon and then drag the Intensity slide
intensity.
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Print Quality is Poor or Cont

Back of Paper is Smudged

■ If the next page prints before the ink is dry, enable the Pause Page pri
setting.

You can either remove each printed sheet from the output tray as soon a
or adjust the Ink Drying Wait Time to pause after each sheet has printed

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab.

3 Click Custom Settings to open the Custom Setting dialog bo

4 Drag the Ink Drying Wait Time slide bar, and then click Send.



ains Errors 136

Troubleshooting

ting Page 

rocedure 

mp flaches 

 test page.
Print Quality is Poor or Cont

Macintosh

1 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

2 Click the Utilities button.

3 Select Custom Settings form the pull-down menu.

4 Drag the Ink Drying Wait Time slide bar, and then click Send.

■ You may need to clean some internal parts of the printer. Follow the p
below.

1 Load sheets of A4 or Letter plain paper in the printer.

2 Hold down the RESUME/CANCEL button until the POWER la
three times, and release the button.

3 Repeat this operation until there are no more smudges on the
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Printed Surface is Scratched

■ Ensure you are using suitable paper.

• The paper weight must be less than 105 g/m2 (28 lb).

If you use non-Canon brand paper heavier than 105 g/m2 (28 lb), the print 
scratch the printed surface.
Clean the print head first and print with the correct paper.

• The paper must not be curled.

This problem can be resolved by simply turning the paper over.

• Before starting Borderless Printing, check the paper that you are using.

With Borderless Printing, the print quality may decrease or smudging may 
top and bottom edges of the paper. Use Photo Paper Pro, Glossy Photo Pa
Paper Plus Glossy or Matte Photo Paper. If smudging still occurs, set the P
Thickness Lever to the right and try printing again.

■ When printing on thick paper, set the paper thickness lever to the righ

This widens a gap between the print head and the paper. If the paper is sc
when printing on plain paper, also try this. When the message suggesting t
position of the lever is not proper displayed, continue printing.
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Print Quality is Poor or Cont

■ Reduce the Intensity setting in the printer driver and try printing again

When printing an image with high intensity, especially on plain paper, the p
absorb too much ink and become wavy. This may cause the printed surface
scratched.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Manual for Colour Adjustment/Colo
Adjustment, and then click Set.

3 Drag the Intensity slide bar to adjust the intensity.
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Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Pri
menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Colour/Color icon and drag the Intensity slide bar 
intensity.

■ Ensure you are printing within the recommended printing area.

➡  Printing Area
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White Streaks

■ Print the nozzle check pattern to check the ink output.

If a specific colour does not print in the nozzle check pattern, clean the prin

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

The problem can also be resolved by aligning the print head. For details on
alignment, refer to "Straight Lines are Misaligned".
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Print Quality is Poor or Cont

Colours are Uneven or Streaked

■ Increase the print quality setting in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Pri
menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Quality icon and then drag the Print Quality slide b
end.
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■ Set the halftoning method to Diffusion in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Custom for the Print Quality setting,

3 Click Diffusion for the Halftoning setting.

Macintosh

1 Open the Print dialog box.

The Print dialog box can normally be opened by selecting Pri
menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Quality icon and then click Diffusion for the Halfton
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Printer Does Not Start or Stops During Print Job

• Printing Does Not Start

• Printing Stops Before It is Completed

• Printer Moves But Does Not Print

• Print Head Holder Does Not Move
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Printing Does Not Start

■ Ensure the printer is turned on.

If the POWER lamp is off, press the POWER button.
If the POWER lamp is flashing green, the printer is initialising. Wait until the
lamp stops flashing.

Note ➤ When printing a large amount of data such as a photo or grap
longer than usual to begin printing. While the POWER lamp is
computer processes the data and sends it to the printer. Simp
the processing is completed.

■ Ensure the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other device, remove and rec
printer directly to the computer. Try printing again.
If printing is now successful, there may be a problem with the
Also there could be a problem with the cable(s). Replace the 
try printing again.
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■ Ensure the correct printer driver is selected.

In Windows, ensure that Canon S330 is selected in the Print dialog box.
In Macintosh, ensure that S330 is selected in the Chooser.

Note ➤ In Windows, you can set the Canon S330 as the default print

■ Ensure the printer port is set correctly. 

Set "USBPRNnn" or "USBnnn" ("n" represents a number) as the printer po

1 Click the Start button, then select Settings, Printers.

2 Select the Canon S330 icon.

3 Open the File menu and select Properties.

4 Click the Details tab (or Ports tab) and set the printer port.

Windows
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inting a large 
process the 

f black ink on 
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 resuming.
off for at least 
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me. Turn the 

 extremely 
Printer Does Not Start or Stops During

Printing Stops Before It is Completed

■ Check the status of the POWER lamp.

When the POWER lamp is flashing green, the printer is processing data. Pr
amount of data such as a photo or graphics takes time for the computer to 
data, during which the printer may appear to not be functioning.

In addition, when continuously printing material that uses a large amount o
plain paper, the printer will sometimes pause. In either case, simply wait un
processing is completed.

■ Halt the print job and turn the printer off for at least 15 minutes to coo
head down.

The print head can overheat when continuously printing for long time. To pro
head, the printer will sometimes pause automatically at a line break before
In this event, interrupt the print job at a convenient time and turn the printer 
15 minutes.

Furthermore, when continuously printing graphics or photos with intense co
printing may stop to protect the print head. In this case, printing will not resu
printer off and wait for at least 15 minutes.

Caution ➤ Inside the printer, the area around the print head can become
hot. Do not touch the print head or nearby components.
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Troubleshooting

ace either of 
 Contact a 
Printer Does Not Start or Stops During

Printer Moves But Does Not Print

■ Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not  print correctly, clean the print head.

➡ Printing the Nozzle Check Pattern

➡ Print Head Cleaning

If the problem is not resolved by cleaning the print head several times, repl
ink tanks. If print quality still remains poor, the print head may be worn out.
Canon service facility.
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lamp is off, 

 moves to the 
over to return 
Printer Does Not Start or Stops During

Print Head Holder Does Not Move

■ Ensure the printer is turned on.

The print head holder will not move unless the power is on. If the POWER 
close the front cover and turn the power on.

If the POWER lamp is flashing green, the printer is initialising.
When the POWER lamp stops flashing, open the front cover again.

■ If the front cover has been left open for a while, close and reopen it.

If the front cover is left open for more than 10 minutes, the print head holder
right to prevent the print head from drying out. Close and reopen the front c
the holder.
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Troubleshooting
Paper Does Not Feed Properly or P

Paper Does Not Feed Properly or Paper Jams

• Paper Does Not Feed Properly

• Envelopes or Post Cards Do Not Feed Properly

• Paper Jams
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Paper Does Not Feed Properly or P

Paper Does Not Feed Properly

■ Confirm the paper conditions.

• If non-Canon brand media, the paper is not too thick (less than 105g/m2 /

• The number of sheets loaded does not exceed the recommended level.

• The paper is not creased, curled or wrinkled.

➡ Compatible Media Types

■ Ensure that the left edge of the paper just touches the paper guide.

■ When printing envelopes, refer to "Envelopes" in "Printing Media," an
the envelopes before printing.

Once you have prepared the envelopes, load them in the printer in portrait 
the envelopes are placed in landscape orientation, they may not feed prope

■ When using transparencies, load one sheet of plain paper in the print
then place the transparencies on top of it.

The last transparency may not feed properly unless there is a sheet of plai
beneath it.
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OWER lamp 

n after the 
Paper Does Not Feed Properly or P

Envelopes or Post Cards Do Not Feed Properly

If envelopes or post cards do not feed properly even after removing curl, cle
feed roller.

1 Ensure the printer is on and there is not any paper loaded in 

2 Hold the RESUME/CANCEL button down and release as the P
flashes three times.

The paper roller starts rotating ten times as it cleans.

Repeat this three times.

3 Load a sheet of A4 or Letter sized plain paper in the printer.

4 Hold the RESUME/CANCEL button down and release as the P
flashes three times feed the sheet.

Repeat this three times.

If the printer still does not feed the envelopes or the post cards through eve
cleaning, repeat these procedures again.
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 the paper 

 the front 
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NCEL button.

s Not Feed 
are loading it 
Paper Does Not Feed Properly or P

Paper Jams

Remove the paper according to the following procedure.

1 Slowly pull the paper out, either from the sheet feeder or from
output slot, whichever is easier.

If the paper tears and a piece remains inside the printer, open
cover and remove it. 

If you cannot pull the paper out, turn the printer off and turn it
paper will be ejected automatically.

2 After removing all paper, close the front cover.

3 Reload the paper into the printer and press the RESUME/CA

Note ➤ When reloading the paper into the printer, refer to "Paper Doe
Properly" to confirm that you are using the correct paper and 
into the printer correctly.



es Orange 153

Troubleshooting

 of error, as 

ANCEL 

rinter 
The POWER Lamp Flash

The POWER Lamp Flashes Orange

An error has occurred in the printer. The number of flashes indicates the type
outlined below. Check the cause and take the appropriate action.

■ Two flashes: Out of paper, paper jam or paper feed error

Replace the paper correctly and press the RESUME/CANCEL button.
If paper has jammed in the printer, clear the jam and press the RESUME/C
button.

■ Three flashes: Paper jam

If paper has jammed in the printer, clear the jam, replace the paper in the p
correctly and press the RESUME/CANCEL button.

➡ Paper Jams
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Troubleshooting

leaning. Eight 
ANCEL 

k tank 
e waste ink 

ccurs. Once 
nger be 
The POWER Lamp Flash

■ Six flashes: No print head installed

Install a print head.

■ Seven flashes: Defective print head

Contact a Canon service representative.

■ Eight flashes: Waste ink tank almost full

The printer has a built-in waste ink tank for the ink used during print head c
flashes indicates that the waste ink tank is nearly full. Press the RESUME/C
button to cancel the error so you can continue printing. Before the waste in
becomes completely full, contact a Canon service representative to have th
tank replaced.

Note ➤ Canon recommends to call for service as soon as this error o
the waste ink tank becomes completely full, printing will no lo
possible.
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 have 

rinter back in 
The POWER Lamp Flash

■ POWER lamp flashes alternate green and orange: 
An error that requires contacting a Canon service representative may
occurred.

Turn the printer off and unplug the printer from the power supply. Plug the p
and turn the printer back on.
If the problem remains, contact a Canon service representative.
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Troubleshooting
An Error Message is Displayed on 

An Error Message is Displayed on the Screen

• Error Writing to USBxxx 

• Application Error or General Protection Fault 

• Other Error Messages 

• Other Error Messages 

Windows

Windows

Windows

Macintosh
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Troubleshooting

 POWER 
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Windows
An Error Message is Displayed on 

Error Writing to USBxxx 

■ Ensure the printer is turned on.

If the POWER lamp is off, turn the printer on.
If the POWER lamp is flashing green, the printer is initialising. Wait until the
lamp stops flashing.

■ Ensure the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other devices, remove and re
printer directly to the computer and try printing again.
If printing is now successful, there may be a problem with the
Also there could be a problem with the cable(s). Replace the 
try printing again.

■ If spooling is enabled, disable it to send the print data directly to the pr
printing again.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly fro

menu
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An Error Message is Displayed on 

2 On the Details tab, click Spool Settings and then select Prin
the printer.
In Windows 2000 or Windows XP, click the Advanced tab and
Print directly to the printer.

■ Verify the USB port status.

1 Right-click My Computer and select Properties.

2 On the Device Manager tab, double-click Universal serial bu
and then double-click Canon S330.
In Windows 2000 or Windows XP, click Device Manager..., U
serial Bus controller on the Hardware tab, and then double
Printing Support.

3 On the General tab, check if there is any indication of a probl
device.
In Windows 2000 or Windows XP, open the USB Printing Su
Properties dialog box to see the General tab.

If an error has occurred, follow the instruction of "Notes on H
USB Interface (for Windows Users)" in the Quick Start Guide.
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An Error Message is Displayed on 

■ Ensure that the printer port setting corresponds to the printer interfac
connection.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly fro

menu

2 On the Details tab (or Ports tab), select USBPRNnn (Canon
USBnnn (Canon S330) ("n" represents a number) in the Prin
following port.

■ There may be a problem in the printer driver. Uninstall the printer driv
reinstall it.

➡ Uninstalling Printer Drivers

Also refer to the procedure “Notes on Handling the USB Interface (for Wind
in the Quick Start Guide.
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Windows
An Error Message is Displayed on 

Application Error or General Protection Fault

■ Ensure the application program you are using is intended for your op
system.

For example, if you attempt to print with a Windows 3.1 application under W
the application may not function correctly and an error may occur.
Use an application program intended for your operating system.

■ If other applications are running, close them to increase available mem
printing again.

■ Ensure that enough memory is allocated to the application.

Refer to the memory requirements of your application.
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An Error Message is Displayed on 

■ Check the amount of free space on the hard disk.

You may need to increase the amount of free space by deleting any unnec

■ If the problem only occurs when printing a specific document, try edit
document and then printing it.

If this resolves the problem, there may have been a problem in the original 
the same problem occurs with the edited document, contact the manufactu
application.

■ There may be a problem in the printer driver.  Uninstall the printer driv
reinstall it.

Also refer to the procedure “Notes on Handling the USB Interface (for Wind
in the Quick Start Guide.

➡ Uninstalling Printer Drivers
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Windows
An Error Message is Displayed on 

Other Error Messages 

■ If the BJ Status Monitor is displayed, follow the instructions on scree

If an error occurs during printing, the BJ Status Monitor displays the error o
Status tab. Follow the instructions on screen.

In Windows 98 or Windows Me, click the Guide tab for action to be taken in
the error.

Refer to "Low Ink Warning Displays Ink Tank with '?'" as it is in the case.
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ing.
An Error Message is Displayed on 

■ If one of the following messages is displayed outside of the BJ Status

Could not spool successfully due to insufficient disk space
Increase the amount of free space on the disk by deleting any unnecessar

Could not spool successfully due to insufficient memory
Increase available memory by closing any other applications currently runn

Printer driver could not be found
Uninstall the printer driver and reinstall it.

➡ Uninstalling Printer Drivers

Background printing failed (Windows 98/Windows Me only)
Restart Windows and try printing again.

Could not print Application name – File name
Try printing again once the current job is finished.
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An Error Message is Displayed on 

Other Error Messages 

■ If a message with the format "Error No.: Xn" (where "X" represents a le
represents a number) is displayed:

Error No.: X202
Not enough memory for printing. Increase available memory by closing any
applications currently running.

Error No.: X203
There is a problem with the printer driver. Uninstall the printer driver and re

➡ Uninstalling Printer Drivers
Error No.: X300
Ensure the power is on, and that the printer and the computer are securely
the problem remains, verify the Chooser setting.

1 In the Apple menu, select Chooser.

2 Click the S330 icon and ensure S330 is selected as the conn
destination.

If it is not selected, select it.

If the problem remains, delete all unnecessary documents from the Extens
Control Panels folder.
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Have you replaced an ink tank with a new one? is

Have you replaced an ink tank with a new one? i
Displayed

If the front cover has been open for a certain period, a confirmation message
replacement may be displayed before the next print job.

■ If the ink tank has been replaced with a new one:

Click Yes to reset the ink counter.

■ If the front cover has been open for a while (the ink tank has not been

Click No to close the dialog box.

■ You can choose to disable the display of a confirmation message.

➡ Modifying the low ink warning setting
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Low Ink Warning Displays Ink Tank with '?'

The ink level of an ink tank displayed with a '?' is not synchronised with its ink

BJ Status Monitor (Windows)

BJ Status Dialog (Macintosh)

The colour ink 
level may not be 
correctly 
displayed.

The c
level 
corre
displa
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Low Ink Warning Displays Ink T

Macintosh

Note ➤ When the background printing is enabled, the low ink warning
the BJ Print Monitor (Macintosh).

➡ BJ Print Monitor

■ Reset the ink counter from the printer driver when you replace the ink

➡ Resetting the ink counter from the printer driver settin

Note ➤ When Display a confirmation message of ink tank replace
selected, a message asking whether or not the ink tank has b
is automatically displayed whenever the ink tank is replaced.

➡ Modifying the low ink warning setting

■ Turn the low ink warning off until you replace the ink tank to stop the 
message.

Windows

1 Ensure the printer is on and open the Printer Properties dialo

➡ Opening the Printer Properties Dialog Box
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Low Ink Warning Displays Ink T

2 On the Maintenance tab, click Low Ink Warning Setting icon

3 Clear a check box of Display low ink warning off and click S

Macintosh

1 Ensure the printer is on and open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by selec
Setup... in the File menu.

2 Click the Utilities icon to open the Printer Utilities dialog box.

3 Select Remaining ink level setting from the pull-down menu
Low Ink Warning Setting icon.

4 Clear a check box of Display low ink warning off and click S

Note ➤ Also refer to "How Low Ink Warning Setting Works" to display
correctly.
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Windows
Problems Unique t

Problems Unique to Windows

• The BJ Status Monitor is Not Displayed

• Cannot Print in Background (Windows 98/Windows Me only)
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Problems Unique t

The BJ Status Monitor is Not Displayed

■ Ensure "Enable bi-directional support for this printer" is selected.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly fro

menu

2 On the Details tab, click Spool Settings and select "Enable b
support for this printer."

In Windows 2000 or Windows XP, select "Enable bi-directiona
the Ports tab.
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Cannot Print in Background (Windows 98/Windo
only)

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space. You may nee
unnecessary files, or disable background printing.

■ Ensure that background printing is enabled.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Page Setup tab, click Printer control... and select Ba
Printing.
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Macintosh
Problems Unique to the

Problems Unique to the Macintosh

• Jagged Text or Graphics, or Banded Gradations

• Cannot Print in Background
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Problems Unique to the

Jagged Text or Graphics, or Banded Gradations

■ Ensure your application supports Quick Draw.

If you are using a PostScript-compatible application, printed text and lines m
jagged and gradations may appear banded. As S330 is not a PostScript pr
Quick Draw printer, use an application compatible with Quick Draw for print
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.

Problems Unique to the

Cannot Print in Background

■ Ensure background printing is enabled.

1 In the Apple menu, select Chooser.

2 Click Backgrounding on.

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space.
You may need to remove unnecessary files, or disable background printing
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Specifications

Printing method:
Bubble Jet on-demand

Printing resolution:
2400 (horizontal) × 1200 (vertical) dpi. max.

Print speed (printing with Canon standard pattern):
Black printing Draft: 14 ppm

Standard: 10.5 ppm
Colour printing Draft: 10 ppm

Standard: 4.7 ppm

Print direction:
Bi-directional

Print width:
203.2 mm max. (8.0 in)
(for borderless printing: 216.0 mm/8.5 in)

Resident print control mode:
Canon extended mode
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ibution pair)
Receive buffer:
56 KB

Interface:
USB 2.0-compatible 

Interface connector:
USB standard Series B receptacle (USB interface)

Recommended printer cable:
Material: AWG28 (data wiring pair) or AWG20 to 28 (distr
Type: Twisted-pair shielded cable
Length: Up to 5.0 m (16.4 ft)
Connectors: USB standard Series B pluggable

Acoustic noise level:
Approx. 45 dB (A) (in the highest print quality mode)

Operating environment:
Temperature: 5 to 35˚C (41 to 95˚F)
Humidity: 10 to 90%RH (no condensation)

Storage environment:
Temperature: 0 to 35˚C (32 to 95˚F)
Humidity: 5 to 90% RH (no condensation)

Power supply:
Europe AC 230 V±10%, 50 Hz
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Specifications
USA/Canada AC 120 V, 60 Hz
Australia AC 240 V, 50 Hz

Power consumption:
Standby: Approx. 2 W
Printing: Approx. 30 W

Dimensions (without a paper rest and paper output tray):
390 (W) × 248 (D) × 185 (H) mm
15.35 (W) × 9.76 (D) × 7.28 (H) in

Weight:
Approx. 3.4 kg (7.48 lb.)
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. (4x6)

ts max. (4x6)
■ Feed method:

Continuous feed through auto sheet feeder
For Plain Paper, Envelopes, High Resolution Paper,
Glossy Photo Paper, High Gloss Photo Film,
Glossy Photo Cards, Photo Paper Pro,
Photo Paper Plus Glossy, Matte Photo Paper
Transparencies, T-shirt Transfers, Banner Paper

■ Sheet feeder capacity:

Plain Paper (75 gsm) 100 sheets max.
High Resolution Paper 80 sheets max.
Envelopes 10 pieces max.
Glossy Photo Paper 10 sheets max.
High Gloss Photo Film 1 sheet
Glossy Photo Cards 20 sheets max.
Photo Paper Pro PR-101 1 sheet (A4/Letter) 20 sheets max
Photo Paper Pro PC-101S 20 sheets max.
Photo Paper Plus Glossy PP-101 10 sheets max. (A4/Letter) 20 shee
Matte Photo Paper MP-101 10 sheets max.
Transparencies 30 sheets max.
T-Shirt Transfers 1 sheet
Banner Paper 1 sheet
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Specifications
■ Ordinary print media:

Regular size: A4, A5, B5, Letter, Legal, European DL, US Com.#10

Custom size: width: 90.0 to 215.9 mm (3.54 to 8.5 in)
height: 120.0 to 584.2mm (4.72 to 23.0 in)

Weight: 64 to 105 g/m2 (17 to 28 lb)

Canon Special media:
High Resolution Paper HR-101N
Glossy Photo Paper GP-301N/GP-301
High Gloss Photo Film HG-201
Glossy Photo Cards FM-101
Photo Paper Pro PR-101
Photo Paper Pro PC-101S
Photo Paper Plus Glossy PP-101
Matte Photo Paper MP-101
Transparencies CF-102
T-Shirt Transfers TR-201
Banner Paper
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r mode with 

 plain paper 
■ Graphic image printing:

Data format: Canon extended mode: Raster image format

Resolution: Canon extended mode: 300, 600, 1200, 2400 dpi

■ Print Head:

Black: 320 nozzles (600 dpi)

Cyan, Magenta, Yellow: 128 nozzles per each colour (600 dpi)

■ Ink Tanks:

Capacity:
Black (BCI-24 Black) approx. 300*1, approx. 580*2

Colour (BCI-24 Color) approx. 170*2

*1 1500 characters per page, normal text, at standard and plain pape
Windows 98/Windows Me

*2 Based on printing the ISO JIS-SCID No.5 pattern at standard and
mode with Windows 98/Windows Me
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.X, which is 
■ Printer driver operating environment:

IBM PC/AT-compatible computer running on Windows 98, Windows M
2000, Windows XP or Macintosh computers with USB interface runnin
8.6  - Mac OS 9.X

■ Hard disk space:

Approx. 15 MB to install on Windows 98 and Windows Me, 30 MB on 
Mac OS 9.X, or approx. 25 MB on Windows 2000 and Windows XP (in
temporary files)

Note ➤ Use the system under the following operating environment.

Windows Computer with Microsoft Windows 98, Windows Me, Windows
Windows XP which is preinstalled by a computer manufacture
purchase. (USB port operation also needs to be assured by th
manufacturer.)

Macintosh Macintosh computers with USB and Mac OS 8.6  - Mac OS 9
preinstalled by a computer manufacturer on purchase.

Specifications subject to change without prior notice.



182

Specifications

h edge of  

is area.  
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ality or the 
■ Printing Area

To ensure the best print quality, the printer allows a margin along eac
media. 

Printing area (dark blue): Canon recommends that you print within th
( )

Printable area (light blue): The area where it is possible to print.  How
in this area can adversely affect the print qu
paper feed precision.  ( )

➡ A4, B5, A5, 4" x 6"

➡ Letter, Legal

➡ Envelopes

➡ Banner Paper
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P-101, 
with no 

dges of 

eight)

1.4 in

.8 in

.9 in

9 in
A4, B5, A5, 4" x 6"

Note ➤ When printing on PR-101, GP-301 / GP-301N, PP-101 and M
selection of "Borderless Printing" enables you to make prints 
margins.
However, borderless printing may cause the top and bottom e
paper to decrease in print quality or become soiled.

Size Printable Area (width x h

A4 203.2 × 289.0 mm / 8.0 × 1

B5 175.2 × 249.0 mm / 6.9 × 9

A5 141.2 × 202.0 mm / 5.6 × 7

4" x 6" 94.8 × 144.4 mm / 5.6 × 7.
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inting area
Recommended pr

Printable area

28.0 mm / 1.1 in

26.5 mm / 1.04 in

3.4 mm / 0.13 in 3.4 mm / 0.13 in

5.0 mm / 0.2 in

3.0 mm / 0.12 in
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P-101, 
with no 

dges of 

eight)

10.7 in

13.7 in

ting area
Letter, Legal

Note ➤ When printing on PR-101, GP-301 / GP-301N, PP-101 and M
selection of "Borderless Printing" enables you to make prints 
margins.
However, borderless printing may cause the top and bottom e
paper to decrease in print quality or become soiled.

Size Printable Area (width x h

Letter 203.2 × 271.4 mm / 8.0 × 

Legal 203.2 × 347.6 mm / 8.0 × 

28.0 mm / 1.1 in

26.5 mm / 1.04 in

6.4 mm / 0.25 in 6.3 mm / 0.25 in

5.0 mm / 0.2 in

3.0 mm / 0.12 in

Recommended prin

Printable area
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eight)

4.1 in

.9 in
Envelopes

Size Printable Area (width x h

European DL 190.5 × 103.2 mm / 7.5 × 

US Com. #10 211.8 × 98.0 mm / 8.3 × 3

3.0 mm / 0.12 in 26.5 mm / 1.04 in

3.4 mm / 0.13 in

3.4 mm / 0.13 in

Printable area
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ght)

 × 69.8 in

8.0 × 65.7 in

 mm / 0.2 in
Banner Paper

Size Printable Area (width x hei

Banner Paper A4: 203.2 × 1774.0 mm / 8.0

Letter: 203.2 × 1668.4 mm / 

3.4 mm / 0.13 in

3.4 mm / 0.13 in

3.0 mm / 0.12 in
28.0 mm / 1.1 in 5.0

Max. 6 sheets
Min. 2 sheets

Recommended printing area

Printable area
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160

59
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69
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26
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61
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A
Amount of Extension 
Application Error 

B
Background printing (Macintosh) 
Background printing (Windows) 
Banner Paper 
BCI-24 Black 
BCI-24 Color 
BJ Print Monitor (Macintosh) 
BJ Status Dialog (Macintosh) 
BJ Status Monitor (Macintosh) 
BJ Status Monitor (Windows) 37, 78
Booklet Printing 
Borderless Printing 

C
Cancelling a Print Job (Macintosh) 
Cancelling a Print Job (Windows) 
Chooser (Macintosh) 
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34, 46, 86
63
96

34, 89
27, 57

77
98

156, 162, 164

26, 57
15, 148

55
160
108
104

106
102
Cleaning 
Client (Macintosh) 
Compatible Media Types 

D
Deep Cleaning 
Duplex Printing 

E
Enabling Low Ink Warning 
Envelopes 
Error Message 

F
Fit to Page Printing 
Front cover 

G
Gamma Correction (Macintosh) 
General Protection Fault 
Glossy Photo Cards FM-101 
Glossy Photo Paper GP-301N/GP-301 

H
High Gloss Photo Film HG-201 
High Resolution Paper HR-101N 
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35, 75
68, 69

35, 77
166

48
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62
85

20

44
25

100, 151
15

152
15
15
44
I
Ink Counter Reset 
Ink Tank 

L
Low Ink Warning 
Low Ink Warning Displays Ink Tank with '?' 

M
Media Type (Macintosh) 
Media Type (Windows) 

N
Network (Macintosh) 
Nozzle Check Pattern 

O
Opening the Printer Properties Dialog Box (Windows) 

P
Page Setup Dialog Box (Macintosh) 
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